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Handleiding

Bedankt voor uw aankoop van dit product.

Lees deze handleiding a.u.b. volledig door om het apparaat te leren kennen en op de juiste manier te kunnen bedie-
nen. Bewaar de handleiding op een veilige plaats op, omdat u ze later beslist nog eens nodig hebt.
Niets uit deze handleiding mag, onder welke vorm dan ook, worden gekopieerd of openbaar gemaakt zonder onze 
schriftelijke toestemming.
Wijzigingen van de technische gegevens en de inhoud van deze handleiding zonder voorafgaande kennisgeving 
voorbehouden.
Alle instructies in deze handleiding zouden eigenlijk moeten kloppen en werden ook gecontroleerd. Als u deson-
danks nog onduidelijke of foute dingen vindt, signaleer het dan even SVP.
Roland DG kan niet aansprakelijk worden gesteld voor directe of indirecte schade die aan een fout gebruik van dit 
apparaat te wijten zou kunnen zijn. Roland DG kan niet aansprakelijk worden gesteld voor directe of indirecte scha-
de c.q. winstderving die aan het gebruik van een met dit apparaat vervaardigd product te wijten zou kunnen zijn.

Roland DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
TYPEBENAMING: Zie de gegevens op het merkplaatje.
TOEPASSELIJKE RICHTLIJN: EG-RICHTLIJN VOOR APPARATEN DIE OP LAGE SPANNING WERKEN (73/23/EEC), 
EG-RICHTLIJN VOOR ELEKTROMAGNETISCHE COMPATIBILITEIT (89/336/EEC).
WAARSCHUWING: Dit is een “klasse A”-apparaat. Bij gebruik ervan in de huiselijke kring zou de ontvangst van uw radio of 
TV kunnen worden gestoord. Doe dan het nodige om de storing te verhelpen.

CutStudio is een handelsmerk van Roland DG Corp.
Windows® is in de VS en/of andere landen een geregistreerd handelsmerk van Microsoft® Corporation.
Macintosh en Mac OS zijn in de VS en andere landen handelsmerken of geregistreerde handelsmerken van Apple Computer, Inc..
Adobe en Adobe Illustrator zijn in de VS en/of andere landen geregistreerde handelsmerken of handelsmerken van Adobe Systems Incorporated.
Corel en CorelDRAW zijn geregistreerde handelsmerken van Corel Corporation of Corel Corporation Limited.
Alle andere vermelde bedrijfs- en productnamen zijn eigendom van de betreffende bedrijven of personen.
Copyright ©2005 Roland DG Corporation
http://www.rolanddg.com/
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Lees deze overeenkomst door alvorens de verpakking van de CD-ROM te openen Door de verzegelde verpakking te 
openen geeft u te kennen het eens te zijn met de volgende voorwaarden en bepalingen.
Roland DG Corporation (“Roland”) verleent u bij deze het niet-overdraagbare en niet-exclusieve recht om de 
COMPUTERPROGRAMMA’S van dit pakket (de “software”) te gebruiken, zolang dit binnen het kader van de vol-
gende voorwaarden en bepalingen geschiedt.

1. Aanvang
Deze overeenkomst treedt in voege wanneer u de aangekochte verzegelde doos van de CD-ROM opent. De looptijd 
ervan begint echter pas, wanneer u de verpakking van de CD-ROM effectief opent.

2. Eigendom
Het auteursrecht (en copyright) van deze software, het logo, de naam, de handleiding en alle andere documentatie 
voor deze software is eigendom van Roland en diens licentiegever. De volgende dingen zijn verboden:

• Ongeoorloofde kopieën van deze software of een ander bijbehorend bestand, van een programmamodule of de do-
cumentatie.

• De analyse, decompilatie of eender welke andere poging om de werking en de broncode van deze software te ach-
terhalen.

3. Uitsluitingen van deze licentie
Roland verleent u niet het recht om deze overeenkomst, de software of de bijgeleverde dingen in licentie te geven, 
te verhuren of aan derden over te dragen c.q. het recht tot gebruik toe te kennen.
U mag deze software niet d.m.v. een timesharing- en/of netwerksysteem voor derden toegankelijk maken, zolang de 
betreffende personen geen gebruikslicentie hebben.
Deze software mag telkens maar door één persoon worden gebruikt, en ook dan uitsluitend op de computer waarop 
de software oorspronkelijk werd geïnstalleerd.

4. Reproductie
U mag één kopie van deze software maken om u veilig te stellen tegen eventuele schade aan de originele datadrager. 
Ook de kopie blijft echter eigendom van Roland.
Deze software mag op de harde schijf van één enkele computer worden geïnstalleerd.

5. Einde
In de volgende gevallen behoudt Roland zich het recht voor om deze overeenkomst meteen op te zeggen:

• Wanneer u eender welke bepaling van deze overeenkomst schendt.
• Wanneer u deze overeenkomst opzettelijk overtreedt of het vertrouwen misbruikt.

6. Beperkingen en aansprakelijkheid
Roland heeft ten alle tijd het recht om de technische gegevens van deze software en het bijbehorende materiaal zon-
der voorafgaande kennisgeving te wijzigen.
Roland kan niet aansprakelijk worden gesteld voor schade die zou kunnen voortvloeien uit het gebruik van deze 
software of de uitoefening van de rechten in verband met deze overeenkomst.

7. Geschillen
In geval van betwisting zijn uitsluitend de Japanse rechtbanken bevoegd. Elk geschil moet dus in Japan beslecht wor-
den.

Roland-licentieovereenkomst

R1–051220
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Kenmerken

    
Bij gebruik van Windows
• Met het bijgeleverde “Roland CutStudio”-programma kunt u bedrukte stickers en letters aanmaken.

Zie “Over de bijgeleverde software” op blz. 11.

• Verder wordt een plug-in voor Adobe Illustrator met de naam “CutStudio Plug-in for Adobe Illustrator” bijgele-
verd. Daarmee kunt u snijdata, die u met Illustrator aangemaakt hebt, naar CutStudio doorseinen en daarmee dan 
stickers en letters uitsnijden.
Zie “Software plug-in overview, installation method” in het elektronische document “Windows Advanced Guide”.

Kenmerken

CutStudio

CutStudio

De vorm van de stickers kunt u zelf bepalen. Zie “Uitsnijden” op blz. 14.

STIKA Sticker

Voor de aanmaak van geprinte stickers hebt u enerzijds de STIKA en anderzijds een geschikte 
printer nodig. Zie het elektronische document “Windows Advanced Guide”.

STIKA Sticker met beeldPrinter

Illustrator
+

CutStudio

Illustrator
+

CutStudio

Vervaardiging van stickers aan de hand van Illustrator-data.
Zie het elektronische document “Windows Advanced Guide”.

STIKA Sticker

Voor de aanmaak van geprinte stickers hebt u enerzijds de STIKA en anderzijds een geschikte 
printer nodig. Zie het elektronische document “Windows Advanced Guide”.

STIKA Sticker met beeldPrinter
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• Verder wordt een plug-in voor CorelDRAW met de naam “CutStudio Plug-in for CorelDRAW” bijgeleverd. Daar-
mee kunt u snijdata, die u met CorelDRAW aangemaakt hebt, naar CutStudio doorseinen en daarmee dan stickers 
en letters uitsnijden. Zie “Software plug-in overview, installation method” in het elektronische document “Win-
dows Advanced Guide”.

• Met het bijgeleverde “STIKA Navi”-programma kunt u de functies van de STIKA vanop uw computer instellen. De 
gebruiksinterface van dat programma is verrassend intuïtief. Zie “STIKA Navi Overview” in het elektronische do-
cument “Windows Advanced Guide”.

Voor de Macintosh
• Met de “CutStudio Plug-in for Adobe Illustrator” plug-in kunt u objecten uitsnijden, die u met Illustrator hebt aan-

gemaakt.
Zie “Als u met een Macintosh-computer werkt” op blz. 13.

CorelDRAW
+

CutStudio

U kunt stickers aan de hand van CorelDRAW-data aanmaken.
Zie het elektronische document “Windows Advanced Guide”.

STIKA Sticker

U kunt bv. nagaan of het materiaal strop zit.
Zie het elektronische document “Windows Advanced Guide”.

STIKA Navi-bedieningsvenster

STIKA

Materiaalstukken, waar nog niets werd uitgesneden, kunt u voor de aanmaak van nieuwe ob-
jecten gebruiken. Zie het elektronische document “Windows Advanced Guide”.

STIKA

Nog bruikbaar materiaal

Klikken

STIKA Navi-bedieningsvenster

Klikken

Illustrator
+

CutStudio

U kunt stickers aan de hand van Illustrator-data aanmaken.
Zie het elektronische document “Macintosh Cutting Guide”.

STIKA

Sticker
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Voorzorgsmaatregelen

                             
Over de OPGELET- en VOORZICHTIG-labels

Andere symbolen

• Open nooit de behuizing en voer nooit wijzigingen aan 
het apparaat door.
Anders bestaat er kans op brand, elektrocutie of verwon-
dingen. Laat alle herstellings- en onderhoudswerken over 
aan een erkende hersteldienst.

• Zorg dat er nooit kinderen in de buurt van dit apparaat 
spelen.
Dit apparaat bevat componenten en onderdelen die ver-
wondingen kunnen veroorzaken. In extreme gevallen kan 
dit leiden tot verblinding, verstikking of andere zware letsels.

• Gebruik uitsluitend accessoires (verbruiksgoederen, 
voeding, stroomkabels e.d.) die uitdrukkelijk voor 
gebruik met dit apparaat worden aanbevolen.
Andere accessoires kunnen verwondingen veroorzaken.

• Sluit het apparaat enkel aan op een stopcontact dat de 
op het merkplaatje van het apparaat vermelde kenmer-
ken vertoont.
Het gebruik van een fout voltage of te weinig stroom kan 
een brand of een elektrocutie veroorzaken.

• Behandel het netsnoer en het gebruikte stopcontact met 
de grootstmogelijke zorg. Wanneer één van beide 
beschadigd is, moet u meteen de aansluiting op het 
lichtnet verbreken.
Anders bestaat er kans op brand, elektrocutie of verwondingen.

• Sluit het apparaat alleen aan op een verlengsnoer dat de 
op het merkplaatje vermelde kenmerken vertoont.
Verder mag u er geen andere apparaten met een hoog 
stroomverbruik op aansluiten, omdat er anders brandge-
vaar bestaat.

• Stel het apparaat altijd zo op dat het netsnoer goed 
bereikbaar is.
In geval van nood moet u de aansluiting op het lichtnet zo 
snel mogelijk kunnen verbreken. Zet het apparaat altijd in 
de buurt van het gekozen stopcontact. Laat voldoende 
ruimte om het netsnoer, indien nodig, meteen uit het 
stopcontact te kunnen trekken.

• Als u iets abnormaals aan het apparaat opmerkt (bv. 
rook, vonken, een vreemde geur, brand of vreemde 
geluiden), moet u meteen de aansluiting op het lichtnet 
verbreken. Gebruik nooit beschadigde kabels e.d.
Anders bestaat er kans op brand, elektrocutie of verwon-
dingen. Neem veeleer meteen contact op met uw Roland 
DG-dealer of een erkende herstellingsdienst.

• Als u het apparaat langere tijd niet wenst te gebruiken, 
verbreekt u het best ook de aansluiting op het lichtnet.
Zo voorkomt u namelijk schade en verwondingen, wan-
neer er iets begint te lekken c.q. wanneer het apparaat 
plots begint te bewegen.

• Gebruik het apparaat nooit buiten c.q. op extreem 
vochtige plaatsen. Bovendien mag het nooit blootge-
steld worden aan regen, een waterstraal e.d. Raak het 
apparaat nooit met natte handen aan.
Anders bestaat er kans op brand of elektrocutie.

Voorzorgsmaatregelen

 OPGELET
Deze boodschap maakt u attent op een risico dat uw leven in gevaar kan brengen of tot zware 
verwondingen kan leiden, als u de richtlijnen niet volgt.

 VOORZICHTIG
Deze boodschap maakt u attent op het gevaar voor mogelijke verwondingen of schade aan het 
apparaat bij fout gebruik ervan.
* Met “materiële schade” bedoelen we hier de beschadiging of andere nadelige invloeden van/
op de woning, de meubelen en zelfs huisdieren.

De driehoek maakt de gebruiker attent op belangrijke instructies of waarschuwingen. De volledige betekenis van de waar-
schuwing wordt echter bepaald door het symbool dat zich in de driehoek bevindt. Zo waarschuwt het hier getoonde sym-
bool bv. dat er gevaar voor elektrocutie bestaat.

Het verbodsteken (doorstreepte cirkel) maakt u attent op handelingen die u nooit mag uitvoeren (ze zijn dus verboden). 
Wat u niet mag doen wordt wederom bepaald door het symbool dat zich in de cirkel bevindt. Zo betekent het links ge-
toonde symbool dat u het apparaat nooit zelf mag openen of modificaties mag uitvoeren.

De zwarte cirkel wijst u op handelingen die u net wél moet doen. Ook hier geldt de regel dat de uit te voeren handeling 
wordt bepaald door het symbool dat zich in deze cirkel bevindt. Zo betekent het links getoonde symbool dat u het nets-
noer uit het stopcontact moet trekken.

OPGELET

Merkplaatje
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 Andere symbolen

                        
• Zorg dat er geen haarspelden, muntstukken, lucifers en 
andere voorwerpen in het inwendige van het apparaat 
belanden. Bovendien mogen er geen vloeistoffen in het 
inwendige van het apparaat druppen.
Muntstukken, lucifers, dranken e.d., die via de ventilatie-
openingen in het inwendige belanden, kunnen een brand 
of een kortsluiting uitlokken. Verbreek dan meteen de aansluiting 
op het lichtnet en neem contact op met een door Roland DG 
erkende herstellingsdienst.

• Zet nooit brandbare voorwerpen op of in de buurt van 
het apparaat. Gebruik nooit brandbare sprays in de 
buurt van dit apparaat. Gebruik het apparaat nooit op 
plaatsen waar de kans op een concentratie van gassen 
bestaat.
Anders is er kans op brand of zelfs ontploffing.

• Voorzichtig: Snijgereedschap.
Dit apparaat bevat een gereedschap (tool). Wees voor-
zichtig om verwondingen te voorkomen.

• Verbreek, alvorens het apparaat of eventuele opties 
schoon te maken, altijd de aansluiting op het lichtnet.
Als u dit niet doet, verhoogt u niet enkel het risico op 
elektrocutie, maar zou u tevens ernstige verwondingen 
kunnen oplopen.

• Plaats het apparaat steeds op een stevig en effen opper-
vlak.
De opstelling van het apparaat op ongeschikte plaatsen 
kan leiden tot zware verwondingen of het kantelen van het appa-
raat.

• Dit apparaat is voor specifieke toepassingen bedoeld en 
mag nooit voor andere doeleinden worden gebruikt. 
Bovendien mag u het nooit overbelasten.
Anders bestaat er namelijk brandgevaar.

Dit apparaat is een precisietoestel. Om de mogelijkheden van dit apparaat ten volle te kunnen benutten moet u tij-
dens het gebruik de volgende dingen in de gaten houden. Doet u dat namelijk niet, dan laat de printkwaliteit niet 
alleen te wensen over, maar zou het apparaat ook stuk kunnen gaan of ondermaatse resultaten kunnen afleveren.

Dit apparaat is een precisietoestel.
Behandel het met de nodige zorg en stel het nooit bloot aan zware schokken, trillingen of geweld.

Ze het apparaat op een geschikte plaats.
• Zorg dat de temperatuur en de luchtvochtigheid op die plaats binnen de vereiste perken liggen.
• Zet het apparaat op een stevige en veilige plaats waar u het zonder moeite kunt bedienen. Zie “Kies de opstellings-

plaats” op blz. 9.

Belangrijke opmerkingen i.v.m. de kabels
Let altijd op een degelijke verbinding van het netsnoer en de verbindingskabels. Zie “Kabels aansluiten” op blz. 10.

Alvorens het apparaat te vervoeren
Als u het apparaat naar een andere plaats moet brengen, moet u het met beide handen aan de onderkant vasthouden. 
Pak het apparaat nooit op andere plaatsen vast om schade te voorkomen.

VOORZICHTIG

Belangrijke opmerkingen voor de bediening en het gebruik
7



 

SV-15/12/8 – 

 

Voorbereidingen voor de opstelling

    
1-1 Bijgeleverde accessoires
Dit apparaat wordt met de volgende dingen geleverd. Controleer daarom na het uitpakken of u alles hebt gekregen:

1. Voorbereidingen voor de opstelling

Adapter Netsnoer USB-kabel Reserve-
mesbeschermer

* De vorm verschilt naar gelang 
het model.

Mesje Cutter, drukpin
*Bij levering zijn de meshouder, het 
mes en de drukpin al geïnstalleerd.

Testmateriaal (gekleurd) Applicatietape 
(doorschijnend)

CD-ROM Handleiding
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 Plaatsing van de labels met de benodigde voeding en het serienummer

          
1-2 Onderdelen

1-3 Plaatsing van de labels met de benodigde voeding en het 
serienummer

1-4 Verwijderen van het verpak-
kingsmateriaal

Om schade tijdens het vervoer te voorkomen is het 
apparaat voorzien van tape, houders enz. Na de in-
stallatie moet u die dingen verwijderen.

Opgelet: Verwijder het verpakkingsmateriaal. Dingen, die 
u niet verwijdert, zouden tijdens het inschakelen func-
tiestoringen en zelfs ernstige defecten kunnen veroorza-
ken.

1-5 Opstelling
Kies de opstellingsplaats

Zet het apparaat op een stevige en veilige plaats waar 
u het zonder moeite kunt bedienen. Bij keuze van 
een ongeschikte opstellingsplaats is de kans op onge-
vallen, brand, functiestoringen of zelfs ernstige scha-
de veel groter.

Opgelet: Gebruik het apparaat nooit buiten c.q. op ex-
treem vochtige plaatsen. Bovendien mag het nooit bloot-
gesteld worden aan regen, een waterstraal e.d. Raak het ap-
paraat nooit met natte handen aan. Anders bestaat er kans 
op brand of elektrocutie.

Aandrukrollen

Mesbeschermer Meshouder

* Laadhendel

Kap van de 
wagenstang

Snijwagen

Aansluiting voor de adapter

USB-aansluiting

[POWER]-knop

[POWER]-indicator

* De SV-15 is rechts en links van een laadhendel (sa-
men dus twee) voorzien. De SV-12/SV-8 heeft er één 
aan de rechterkant.

Wiel voor het
materiaaltransport

Serienummer
Het serienummer moet u vermelden, wanneer u het ap-
paraat wilt laten herstellen of hulp wilt inroepen. Verwijder 
dit label nooit en zorg dat het altijd goed leesbaar is.

Voeding
Sluit het apparaat altijd aan op een stopcontact dat 
aan de hier vermelde eisen voldoet.

Verpakkingsmateriaal
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Voorbereidingen voor de opstelling

                        
Opgelet: Zet nooit brandbare voorwerpen op of in de 
buurt van het apparaat. Gebruik nooit brandbare sprays in 
de buurt van dit apparaat. Gebruik het apparaat nooit op 
plaatsen waar de kans op een concentratie van gassen be-
staat. Anders is er kans op brand of zelfs ontploffing.
Opgelet: Stel het apparaat altijd zo op dat het netsnoer 
goed bereikbaar is. In geval van nood moet u de aansluiting 
op het lichtnet zo snel mogelijk kunnen verbreken. Zet het 
apparaat altijd in de buurt van het gekozen stopcontact. 
Laat voldoende ruimte om het netsnoer, indien nodig, 
meteen uit het stopcontact te kunnen trekken.
Opgelet: Plaats het apparaat steeds op een stevig en effen 
oppervlak. De opstelling van het apparaat op ongeschikte 
plaatsen kan leiden tot zware verwondingen of het kante-
len van het apparaat.

Niet geschikte opstellingsplaatsen
• Plaatsen die aan sterke schokken of trillingen onder-

hevig zijn.
• Hellende plaatsen of oneffen oppervlakken.
• Stoffige plaatsen.
• In de buurt van sterke elektrische of magnetische vel-

den c.q. andere vormen van elektromagnetische 
energie.

• Plaatsen waar de warmte onvoldoende kan worden 
afgevoerd.

Afmetingen van de opstellingsplaats

1-6 Kabels aansluiten
Opgelet: Sluit het apparaat enkel aan op een stopcontact 
dat de op het merkplaatje van het apparaat vermelde ken-
merken vertoont. Het gebruik van een fout voltage of te 
weinig stroom kan een brand of een elektrocutie veroorza-
ken.
Opgelet: Behandel het netsnoer en het gebruikte stopcon-
tact met de grootstmogelijke zorg. Wanneer één van beide 
beschadigd is, moet u meteen de aansluiting op het lichtnet 
verbreken. Anders bestaat er kans op brand, elektrocutie of 
verwondingen.
Opgelet: Sluit het apparaat alleen aan op een verlengsnoer 
dat de op het merkplaatje vermelde kenmerken vertoont. 
Verder mag u er geen andere apparaten met een hoog 
stroomverbruik op aansluiten, omdat er anders brandge-
vaar bestaat.
Opgelet: Gebruik uitsluitend hoogwaardige adapters, die 
compatibel zijn met dit apparaat. Bij gebruik van een niet 
compatibele adapter zou u het apparaat zwaar kunnen be-
schadigen.

Gebruik de bijgeleverde USB-kabel voor het aanslui-
ten op uw computer.
Opgelet: Sluit de USB-kabel pas aan, wanneer het driver-
installatieprogramma daarom vraagt. Als u de USB-kabel 
al vóór de installatie van de driver aansluit, wordt deze 
laatste eventueel niet naar behoren geïnstalleerd, zodat het 
apparaat niet wordt herkend. Zie “Driver installeren” op 
blz. 11.
Opgelet: Werk nooit met een USB-hub e.d.

Tijdens het uitsnijden beweegt het materiaal voor- en 
achteruit. Zet dus geen voorwerpen vóór of achter het 
apparaat. Plaats het apparaat nooit vlakbij een muur en 
zet het nooit in een gesloten kast.

Zorg ervoor dat het wiel 
voor het materiaaltrans-
port nooit door andere 
voorwerpen wordt geb-
lokkeerd.

Stel het apparaat altijd 
zo op dat u de aanslui-
ting op het lichtnet in ge-
val van nood meteen 
kunt verbreken.

Adapter Netsnoer

Aansluiting voor de adapter

USB-kabel
Voeding

Opgelet: Sluit de USB-
kabel NOG NIET aan.
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 Installeren van de programma’s

                                     
1-7 Installeren van de 
programma’s
Hier gaan we tonen hoe je de bijgeleverde program-
ma’s installeert.

Over de bijgeleverde software
De bijgeleverde CD-ROM bevat de volgende soft-
ware.
Software voor Windows
STIKA-driver—Deze driver zorgt ervoor dat de snij-
commando’s van de computer naar het apparaat 
worden doorgeseind. Die moet u absoluut installe-
ren.

STIKA Navi—Dit programma is bedoeld voor de af-
standsbediening van het apparaat vanop uw compu-
ter. Hiermee kunt u het mesje naar de gewenste 
plaats brengen en de materiaaldoorvoer testen. Het 
programma wordt samen met de STIKA-driver geïn-
stalleerd.

Roland CutStudio—“Roland CutStudio” is een pro-
gramma waarmee u enerzijds snijdata kunt aanma-
ken en de objecten anderzijds kunt uitsnijden.

CutStudio plug-in voor Adobe Illustrator—Met 
deze plug-in kunt u objecten, die u met Adobe Illus-
trator hebt aangemaakt, meteen uitsnijden.

CutStudio plug-in voor CorelDRAW—Met deze 
plug-in kunt u objecten, die u met CorelDRAW hebt 
aangemaakt, meteen uitsnijden.

Software voor Macintosh
CutStudio plug-in voor Adobe Illustrator—Met 
deze plug-in kunt u objecten, die u met Adobe Illus-
trator hebt aangemaakt, meteen uitsnijden.

Als u met een Windows-computer werkt
Systeemvereisten
Systeemvereisten voor de USB-verbinding
Een USB-verbinding werkt alleen onder Windows, 
als de computer aan de volgende voorwaarden vol-
doet. Alle andere configuraties zijn niet compatibel.

Systeemvereisten voor Roland CutStudio

Systeemvereisten voor de STIKA-driver

Driver installeren
Naast de driver wordt tevens STIKA Navi geïnstal-
leerd.
Opgelet: Verbind het apparaat pas met de computer, wan-
neer dit uitdrukkelijk wordt gevraagd. Doet u dat namelijk 
niet, dan wordt de driver fout of maar gedeeltelijk geïnstal-
leerd. Zie “Eerste hulp bij problemen…” op blz. 30.

A Ga dus vóór het starten van de installatie na of de 
USB-kabel wel degelijk NIET is aangesloten.

B Start Windows. Als u de software onder Windows 
2000/XP installeert, moet u aanloggen als “beheer-
der” of een gebruiker met dezelfde machtigingen.

C Stop de bijgeleverde CD-ROM in de drive.
Na enkele seconden verschijnt het volgende menu.

D Klik op [Install].
De “Installation and Setup Guide” verschijnt. Onder 
Windows 98 SE, Windows Me en Windows 2000 
verschijnen de “Installation and Setup Guide” en het 
“Setup”-programma.

Besturingssys-
teem

Windows 98 SE (Second Edition)/Me/2000/XP

Computer 1) Computer waarop Windows 98 SE/Me/
2000/XP bij levering geïnstalleerd is of waar-
op u op een later tijdstip Windows Me/2000/
XP installeert.
2) De computer moet voorzien zijn van een 
werkende USB-poort.

Besturingssys-
teem

Windows 98 SE (Second Edition)/Me/2000/XP

Computer Als u met een Windows-computer werkt

Drive CD-ROM-drive

Scherm Windows-compatibel scherm met minimaal 
16-bit kleuren (“High Color”)

Werkgeheu-
gen (RAM)

128MB of meer

Beschikbare ca-
paciteit op de 
harde schijf 
(voor de instal-
latie)

10MB

Besturingssys-
teem

Windows 98 SE (Second Edition)/Me/2000/XP

Computer 1) Computer waarop Windows 98 SE/Me/
2000/XP bij levering geïnstalleerd is of waar-
op u op een later tijdstip Windows Me/2000/
XP installeert.
2) De computer moet voorzien zijn van een 
werkende USB-poort.

Klik op [Install].
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Voorbereidingen voor de opstelling

                        
E Voer de instructies van de “Installation and Setup 
Guide” uit om de software te installeren.

Als het “Driver Setup”-venster niet verschijnt.
Bij gebruik van Windows 98 SE, Windows Me of 
Windows 2000 kan het gebeuren dat het setuppro-
gramma niet wordt gestart. Controleer dan eerst de 
taakbalk onderaan het scherm. Verschijnt 
[Driver Setup] daar wél, dan draait het programma. 
Ga naar de taakbalk en klik op [Driver Setup] om het 
venster van het installatieprogramma te zien.

CutStudio installeren
Installeer het programma “CutStudio”.

A Selecteer het menu van de software (“Roland STIKA 
Software Package”).

B Klik op [Install].
Voer alle instructies uit om de installatie te vol-
tooien. Installeer vervolgens de “Windows Advanced 
Guide”.

Online-hulp van Roland CutStudio selecteren.
Klik op [Start], breng de muiswijzer naar [Alle pro-
gramma’s] (of [Programma’s]), kies vervolgens 
[Roland CutStudio] en tenslotte [CutStudio Help].

* U kunt de online-hulp ook via het menu van Cut-
Studio oproepen.

Installeren van de ‘Windows Advanced Guide’
A Selecteer het menu van de software (“Roland STIKA 

Software Package”).

B Klik op [Install].
Het “Setup”-venster verschijnt. Voer alle instructies 
uit om de installatie te voltooien.

C Klik op [X] rechtsboven in het “Setup”-menu om het 
venster te sluiten.

Lezen van de ‘Windows Advanced Guide’
Klik op [Start], breng de muiswijzer naar [Alle pro-
gramma’s] (of [Programma’s]), kies vervolgens 
[Roland SV Series Manual] en tenslotte 
[Advanced Guide].

CutStudio-plug-in installeren
Meer details over de CutStudio-plug-in vindt u in 
het elektronische document “Windows Advanced 
Guide”.

Hierop klikken.Taakbalk

Klik op [Install].
Het “Setup”-
venster verschijnt.

Klik op [Install].
Het “Setup”-
venster verschijnt.
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Als u met een Macintosh-computer werkt
Systeemvereisten
Sluit de STIKA alleen op een Macintosh aan, die aan 
de volgende voorwaarden voldoet.
BESTURINGSSYSTEEM: Mac OS 9 of recenter (de 
versies Adobe Illustrator 9/10/CS werken feilloos)

Installeren van de programma’s
Meer details over het installeren van het programma 
“Macintosh Cutting Guide” vindt u in de “Mac OS 
Installation and Setup Guide” op de bijgeleverde 
CD-ROM. Ziehier hoe u zorgt dat uw Macintosh dat 
bestand afbeeldt. Volg daarna de op het scherm ver-
schijnende instructies voor de installatie.

A Stop de bijgeleverde CD-ROM in de drive.

B Het “Roland SV Series”-symbool verschijnt op het 
bureaublad. Dubbelklik erop.

C Dubbelklik op het “Install_e.html”-icoontje.
Nu verschijnt de “Mac OS Installation and Setup 
Guide”.

Voer de instructies van de “Mac OS Installation and 
Setup Guide” uit om de software en de “Macintosh 
Cutting Guide” te installeren.
13



SV-15/12/8 – Uitvoeren van snijopdrachten
Hier wordt uitgelegd hoe u vanop een Windows-computer snijopdrachten uitvoert. Dingen, die hier niet aan bod 
komen, worden in de “Windows Advanced Guide” (elektronische handleiding) uitgelegd.

2-1 Alvorens aan de slag te gaan
Ondersteunde materiaaltypen

Dit apparaat laat het gebruik van de volgende materiaaltypen toe:

* Sommige materiaaltypen kunt u met dit apparaat niet uitsnijden.

Gebruik nooit materiaal met de volgende kenmerken. Anders zit het materiaal binnen de kortste keren strop.
• Materiaal dat naar omhoog krult.
• Materiaal dat aan de voorkant niet recht is afgesneden.
• Materiaal waarvan de linker- en rechterrand niet parallel lopen.
• Materiaal dat langer is dan 1100mm.

Materiaal op rol gebruiken
Rolmateriaal moet u na het uitsnijden van een object 
nog minstens 40mm verder uitvoeren om het object 
te kunnen afsnijden zonder het te beschadigen. De 
maximale materiaallengte, die het apparaat kan ver-
werken, bedraagt 1100mm. Het snijdbaar oppervlak 
is echter beperkt tot 1000mm.

Opgelet: Snijd het materiaal altijd recht af. Als u het name-
lijk scheef snijdt, is de kans groot dat het materiaal tijdens 
het uitsnijden van het volgende object functiestoringen 
veroorzaakt. Het zou zelfs kunnen gebeuren dat het mate-
riaal onder de aandrukrollen wegschuift en los komt te zit-
ten.

2-2 Uitsnijden
Laten we nu kijken hoe je het volgende object voor-
bereidt en vervolgens uitsnijdt.

Voer die hierna vernoemde stappen in de vermelde 
volgorde uit.

Stap 1: Materiaal laden
A Schakel het apparaat uit.

B Kijk of het materiaal kan worden geladen en of het de 
aandrukrollen raakt.

2. Uitvoeren van snijopdrachten

SV-15 SV-12 SV-8

Afmetingen • Breedte: 360~381mm; 
280~305mm (lengte: A3, breedte: 
A4). Zie “Wijzigen van de materi-
aalbreedte (alleen voor de SV-15)” 
op blz. 15.

• Lengte: Maximaal 1100mm

• Breedte: 280~305mm (lengte: A3, 
breedte: A4)

• Lengte: Maximaal 1100mm

• Breedte: 200~215mm (lengte: A4)
• Lengte: Maximaal 1100mm

Materiaaltypes* • Vinylfolie (maximale dikte: 0,1mm; maximale dikte met onderlaag: 0,3mm)
• labelpapier (maximale dikte met onderlaag: 0,3mm)

Up to 
1100 mm  
(43-1/4 in.)

Maximaal 
1100mm

Aandrukrol

Het materiaal moet parallel met de aandrukrollen lopen.
14



Handleiding Alvorens aan de slag te gaan
Opgelet: De aandrukrollen van de SV-15 kunt u verschui-
ven, wat dus toelaat om ook smaller materiaal te laden. 
Laad het materiaal pas nadat u dat gedaan hebt. Zie “Wij-
zigen van de materiaalbreedte (alleen voor de SV-15)” op 
blz. 15.

C Schik het materiaal zo dat het parallel met de hulplijn 
loopt.

Als dat niet het geval is, moet u het materiaal zo ver 
naar binnen trekken dat het enerzijds parallel loopt 
en anderzijds onder de aandrukrollen ligt.

D Draai aan het transportwiel om het materiaal verder 
in het apparaat te voeren. Draai het wiel vervolgens 
weer achteruit. Het materiaal mag niet onder de aan-
drukrollen wegschuiven.

Als het materiaal scheef werd geladen c.q. als het on-
der de aandrukrollen wegglipt, moet u het opnieuw 
laden.

E Gebruik de mesbeschermer ter oriëntatie tijdens de 
schikking van het materiaal.

Laden van het testmateriaal
De richting in dewelke u het testmateriaal moet la-
den verschilt naar gelang het gebruikte model.

SV-15/SV-12— In de breedte (liggend)

SV-8—In de lengte (staand)

Als u met een SV-15 werkt, moet u de breedte van 
het te laden materiaal op 280~305mm zetten. Zie 
verderop.

Wijzigen van de materiaalbreedte (alleen voor de 
SV-15)
Als u met een SV-15 werkt, moet u de breedte van 
het te laden materiaal op 360~381mm of 
280~305mm zetten. De breedte-instelling wordt be-
paald door de positie van de aandrukrollen en verder 
door de driverparameters.

A Til de rechter laadhendel op.

B Verwijder de stopper van de aandrukrol.

Opgelet: Ga tijdens het verwijderen van de stopper voor-
zichtig tewerk om hem niet te beschadigen. Als u hem na-
melijk te ver opent, komt hij op een later tijdstip, wanneer 
u hem opnieuw installeert, eventueel los te zitten.

C Schuif de rechter aandrukrol naar de materiaalrand 
en installeer de stopper opnieuw.

Hulplijn

Wiel voor het materiaaltransport

Laadhendel (rechts)

Stopper van de aandrukrol

Aandrukrol
280~305mm

Aandrukrol
360~381mm
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SV-15/12/8 – Uitvoeren van snijopdrachten
D Laat de rechter laadhendel weer zakken.

E Laad het materiaal.

Zie “Stap 1: Materiaal laden” op blz. 14.

F Stel in de driver de grootte van het snijgebied in.
Zie verderop.

Stap 2: Snijdata aanmaken
Gebruik het programma “CutStudio” voor de aan-
maak van het object (de snijdata). Meer details over 
het werken met CutStudio vindt u in de online-hulp 
van de software.
Opgelet: Als u met Windows 2000/XP werkt, moet u aan-
loggen als “beheerder”.

Start CutStudio.

A Klik op [Start].

B Kies [Alle programma’s] (of [Programma’s]), dan 
[Roland CutStudio] en klik tenslotte op [CutStudio].

Stel de parameters voor het snijgebied in.

A Klik eerst op [File] en vervolgens op [Cutting Setup].

Het “Cutting Setup”-venster verschijnt.

B Kies met [Name] het apparaat dat u gebruikt.

C Klik op [Properties].
Het “Properties”-venster verschijnt.

D Klik op de [Size]-tab.

E Het snijgebied moeten altijd in functie van de mate-
riaalafmetingen worden gekozen.

• Klik op [ ] en zet de breedte hetzij op 250, hetzij 
op 340mm (alleen bij de SV-15).
Opgelet: Als u met het testmateriaal wilt werken, moet u 
“250mm” kiezen.
Opgelet: Op de SV-12/SV-8 kan de materiaalbreedte niet 
worden gewijzigd.

Laadhendel (rechts)

280~305mm

360~381mm

[Size]-tab

Snijgebied
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Handleiding Alvorens aan de slag te gaan
• Kies voor “Length” altijd een waarde die iets korter is 
dan de materiaallengte (omdat er een marge moet 
blijven).
Zie “Snijgebied” op blz. 25.

F Klik op [OK].

G Klik opnieuw op [OK] om het “Cutting Setup”-ven-
ster te sluiten.
Het snijgebied is nu ingesteld.

Maak de tekst of de vormen aan die u wilt uitsnijden.
In dit voorbeeld gaan we de letters “SALE” aanma-
ken. Om de folie errond sneller te kunnen verwijde-
ren trekken we er bovendien een kader rond.

A Klik op [ ].

B Klik op eender welke plaats binnen het witte gebied en 
typ “SALE”.

C Klik op [ ].
Rond de tekst ziet u - en �-symbolen.

D Met de - en �-symbolen kunt u de lettergrootte en 
-breedte wijzigen.

E Klik op [ ].

F Trek een rechthoek rond de “SALE”-tekst.
Klik op de linker bovenhoek en sleep het symbool 
naar de rechter benedenhoek om de afmetingen te 
wijzigen.

G Klik op [ ].
Kies het gebied dat de benodigde tekst en vormen be-
vat. Na de keuze hiervan wordt de lijn in het blauw 
afgebeeld. Breng de cursor naar de bovenkant van 
het venster (in de buurt van de oorsprong).

H Klik op [Save].

Het witte gebied vertegen-
woordigt het snijgebied. Let-
ters of vormen buiten dit ge-

bied worden niet uitgesneden.

Klik erop en sleep het naar de
gewenste positie.

Vertrekpunt

Breng de wijzer naar een plaats binnen de tekst. Zo-
dra de wijzer in een plus verandert, kunt u het gese-
lecteerde object naar een andere plaats slepen.
17



SV-15/12/8 – Uitvoeren van snijopdrachten
Het “Save As”-venster verschijnt.

I Kies bij “Save in” de gewenste map.

J Typ de naam van het nieuwe bestand in en klik op 
[Save].
De aangemaakte data worden opgeslagen.

Belangrijke opmerking i.v.m. het opslaan van data
Het met [File]>[Cutting Setup]>[Properties] geko-
zen snijgebied wordt niet opgeslagen. Als u de data 
later weer importeert, moet u het snijgebied met het 
[Cutting Setup]-commando opnieuw instellen.

Stap 3: Uitsnijden
Alvorens een opdracht te starten moet u de volgende 
dingen doen: “Stap 1: Materiaal laden” (blz. 14) en 
“Stap 2: Snijdata aanmaken” (blz. 16).

A Druk op de [POWER]-knop om het apparaat in te 
schakelen.

De [POWER]-indicator knippert. De wagen gaat nu 
naar de linkerrand van het apparaat. Als de indicator 
blijft branden, is het apparaat klaar om uit te snijden.

B Klik op [Cutting].

C Klik op [OK].

De computer zendt de snijdata en de snijopdracht 
wordt uitgevoerd. De tekst “SALE” en de kader wor-
den uitgesneden.

D Druk op de [POWER]-knop om het apparaat uit te 
schakelen.
De [POWER]-indicator moet doven.

E Draai aan het transportwiel om het materiaal uit het 
apparaat te kunnen halen.

Een snijopdracht halverwege stoppen
A Druk op de [POWER]-knop om het apparaat uit te 

schakelen.
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Handleiding Alvorens aan de slag te gaan
B Druk opnieuw op de [POWER]-knop om het apparaat 
weer in te schakelen.

De snijwagen gaat nu naar de linkerrand van het ap-
paraat.
Opgelet: Als u een snijopdracht met hetzelfde materiaal 
wilt herhalen, moet u het eerst verwijderen en daarna op-
nieuw laden.
Opgelet: U kunt een opdracht ook met “STIKA Navi” 
stoppen. Meer details hierover vindt u in het elektronische 
document “Windows Advanced Guide”.

Stap 4: Het uitgesneden object aanbrengen
Voor het aanbrengen van een uitgesneden object 
hebt u applicatietape nodig. Snijd een stuk applica-
tietape met de benodigde afmetingen af. Alvorens 
het object aan te brengen moet u de plaats van be-
stemming schoonmaken (stof en vet verwijderen).

A Verwijder alle overbodige materiaaldelen om te zor-
gen dat alleen de tekst overblijft.

Voor het verwijderen van kleine materiaaldeeltjes 
gebruikt u het best een pincet.

B Snijd een stuk applicatietape met de benodigde afme-
tingen af.

Breng de applicatietape op zo’n manier op het object 
aan dat er nergens luchtbellen te zien zijn. Vervol-
gens kunt u het object dan op de gewenste plaats aan-
brengen.
Opgelet: Met een in de handel verkrijgbare wisser of een 
plat voorwerp (bv. een liniaal) kunt u het materiaal stevig 
tegen de applicatietape drukken.

C Breng het object samen met de applicatietape op de 
gewenste plaats aan en druk beide stevig vast.

D Ga eerst na of het materiaal goed op de plaats van be-
stemming kleeft en verwijder vervolgens voorzichtig 
de applicatietape.

Opgelet: Als u bepaalde luchtbellen niet uit het object kunt 
verwijderen, kunt u die met een naald doorprikken om de 
lucht te laten ontsnappen. Druk dat gebied vervolgens ste-
vig vast.
Het object is nu op de gewenste plaats aangebracht.

Na het uitsnijden
Uitgesneden objecten moet u zo snel mogelijk op de 
plaats van bestemming aanbrengen. Laat u ze te lang 
liggen, dan zou het stof aan de randen van de vormen 
ervoor kunnen zorgen dat die partijen achteraf niet 
lang blijven kleven.

Applicatietape
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SV-15/12/8 – Functies van de STIKA
Hier komt u te weten hoe de meshoogte in te stellen, 
het materiaal recht te laden en snijdata aan te maken.

3-1 Snijparameters op het 
materiaal afstemmen

Controle van de snijparameters
Een optimaal resultaat kunt u alleen behalen, wan-
neer u vóór elke belangrijke opdracht een snijtest 
doorvoert om de instellingen te controleren. Dit is 
tevens noodzakelijk, wanneer u met een ongewoon 
materiaaltype werkt of de meshoogte moet controle-
ren.
Opgelet: Vóór het starten van een snijtest moet u materiaal 
laden. Doet u dat namelijk niet, dan worden het mesje en 
de mesbeschermer beschadigd.
Opgelet: Verschuif de cutterwagen nooit met de hand. 
Daarmee zou u het apparaat namelijk kunnen beschadi-
gen.
Opgelet: Raak nooit bewegende onderdelen aan, terwijl 
het apparaat een opdracht aan het uitvoeren is. Dat zou 
namelijk defecten kunnen veroorzaken.

A Laad materiaal.
Zie “Stap 1: Materiaal laden” op blz. 14.

B Activeer de [POWER]-schakelaar (de indicator moet 
oplichten) en houd hem minstens 2 seconden inge-
drukt.

C Zodra de wagen begint te bewegen, kunt u de knop 
weer loslaten.

De snijopdracht begint vanaf de huidige mespositie. 
Het verderop getoonde object wordt uitgesneden.

Als u later opnieuw een snijtest wilt uitvoeren, moet 
u de [POWER]-toets opnieuw 2 seconden of meer 
ingedrukt houden. (Wacht echter altijd tot de laatst 
gestarte opdracht voltooid is.) Voor een dergelijke 
test wordt automatisch een gebied gekozen dat zich 
ver genoeg van het laatst uitgesneden object vandaan 
bevindt.

D Verwijder de uitgesneden vormen en controleer hun 
kwaliteit even.
De snijkwaliteit wordt in belangrijke mate bepaald 
door de meshoogte. Als de testobjecten niet naar be-
horen kunnen worden verwijderd, moet u de mes-
hoogte meer dan waarschijnlijk wijzigen. Zie “Mes-
hoogte instellen” verderop.

Als het mes een licht spoor op de onderlaag heeft 
achtergelaten
Dit betekent dat de meshoogte optimaal is. In dit ge-
val hoeft er dus niets gecorrigeerd te worden.

Het materiaal kan met moeite van de onderlaag worden 
gehaald.
Het spoor van het mesje is onzichtbaar.
De snijpaden worden niet overal op dezelfde manier 
uitgesneden.

Kies een grotere meshoogte.

Het spoor van het mesje is te diep: hier en daar heeft het 
door de onderlaag heen gesneden.
Het mesje heeft gewoon door de onderlaag gesne-
den.
Het materiaal golft tijdens het uitsnijden.

Verminder de meshoogte.

Meshoogte instellen
Opgelet: Raak het mesje nooit met blote vingers aan. An-
ders is de kans op verwondingen namelijk betrekkelijk 
groot.

A Schakel het apparaat uit.

3. Functies van de STIKA

2 seconden 
of meer

Optimale 
meshoogte

Te geringe 
meshoogte.

Overdreven 
meshoogte.
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Handleiding Alvorens aan de slag te gaan
B Draai de schroeven los en haal de meshouder uit de 
wagen.

C Stel de meshoogte in.

Draai de kap in de getoonde richting om de mes-
hoogte op te voeren. Elke stap komt overeen met 
0,1mm.

D Stut de schroef af, terwijl u de meshouder weer instal-
leert.

E Draai de schroef weer aan.

Trek de cutter voorzichtig omhoog om te controle-
ren of hij goed vast zit.

F Start de snijtest en ga na of de instellingen een beter 
resultaat voor het gebruikte materiaal opleveren.
Herhaal deze procedure zo vaak tot de snijkwaliteit 
optimaal is. Zie “Controle van de snijparameters” op 
blz. 20.

Ruwe schatting van de meshoogte
Aan de hand van de volgende formule kunt u de on-
geveer juiste meshoogte berekenen.

* Tip

Wanneer de meshoogte optimaal is, zijn de snijba-
nen duidelijk op de onderlaag te zien.

3-2 Andere schikking van het 
materiaal

Als het materiaal niet recht werd ingevoerd, kan het 
tijdens het uitsnijden verschuiven. U kunt de laad-
hendel(s) optillen om het materiaal te verschuiven.

A Til de laadhendel op.

B Schuif het materiaal afwisselend voor- en achteruit 
tot het parallel met de hulplijn loopt.

C Laat de laadhendel zakken om het materiaal klem te 
zetten.

Schroef

Meshouder

0,1mm

De punt van het mesje is 
nauwelijks te zien.

Moet de houder
raken Langs onder 

afstutten.

Schroef

Meshouder

Meshoogte Dikte van het ge-
laden materiaal

Dikte van de 
onderlaag= +

2

Meshouder

Helft van de 
onderlaagdikte

Mesje

Onderlaag

Materiaal

De meshoogte komt 
ongeveer overeen met 
de snijdiepte.

Laadhendel

Hulplijn
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3-3 Over de snijdata
Voorbereiden van tekstdata

Hier wordt uitgelegd hoe u de lettergrootte en het 
lettertype via het “Properties”-venster kunt wijzigen.
CutStudio laat het gebruik van “TrueType”- en 
“OpenType”-lettertypen toe, die op “TrueType” ge-
baseerd zijn.

A Klik op [ ].

B Klik op de plaats waar de tekst moet beginnen.

C Klik op [Format]> [Font].

Het “Properties”-venster verschijnt.
U kunt het “Properties”-ook op de volgende manier 
oproepen.

• Klik op [Format]> [Properties].
• Klik met de rechter muisknop en kies in het dan ver-

schijnende menu [Properties].

D Wijzig de grootte en het lettertype van de tekst.

[1] Om een ander lettertype te kiezen moet u op [ ] onder “Font” 
klikken. Kies vervolgens het lettertype.
[2] Om de tekstgrootte te wijzigen klikt u op het [Text Height]-veld 

en voert u de gewenste waarde in. De breedte verandert eveneens in 
verhouding tot de grootte.

E Klik op [OK].
De tekst verandert nu conform de gemaakte instel-
lingen.
Meer details over “Properties” vindt u in de online-
hulp van “Roland CutStudio”.

F Klik op [ ].

G Trek een kader rond de tekst.
Het verdient aanbeveling om de ingevoerde tekst te 
voorzien van een kader, omdat u hem dan gemakke-
lijker op de gewenste plaats kunt aanbrengen.
Als u kleine letters moet uitsnijden, is het een goed 
idee om rond elke letter een kader te trekken.

H Klik op [Save].

Het “Save As”-venster verschijnt.

I Kies met “Save in” de gewenste map.

J Typ de naam van het nieuwe bestand in en klik op 
[Save].
De aangemaakte data worden opgeslagen.

[2]

[1]

Slepen
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BMP/JPG-data importeren
CutStudio kan ook data in het BMP/JPG-formaat 
importeren. De contouren (Outlines) van dergelijke 
beelden worden automatisch herkend en kunnen 
worden uitgesneden. Dat werkt echter niet voor alle 
vormen. Houd rekening met de onderstaande beper-
kingen terwijl u objecten aanmaakt. Houd, voor de 
aanmaak van beelddata die u in CutStudio wilt ge-
bruiken, de volgende voorwaarden in de gaten.

Waar u rekening mee moet houden
• Kleuren mogen niet in elkaar overvloeien, maar 

moeten strak gescheiden zijn.
• Het verdient aanbeveling om enkel zwart en wit te 

gebruiken.
• Bovendien importeert u het best geen digitale foto’s 

of scans, omdat die in de regel grijswaarden bevatten.

Kies een hoge resolutie.
• De optimale resolutie hangt echter af van de com-

plexiteit en de omvang van het object.
• Beelden met een hoge resolutie zijn echter ook wat 

lijviger, zodat de import in CutStudio eventueel iets 
langer duurt.

A Klik eerst op [File] en vervolgens op [Import].

Het “Import”-venster verschijnt.

B Kies het benodigde bestand.

C Klik op [Open].
De geladen data worden afgebeeld.

D Stel de afmetingen en de gewenste positie van het ob-
ject in.

E Klik op [Object]> [Image Outline].

Het “Image Outline”-venster verschijnt.

F Klik op [Extract Contour Lines].
Nu worden de contouren van het beeldbestand ach-
terhaald.
Opgelet: De contouren worden met behulp van een blau-
we lijn weergegeven.

G Kijk even of de contouren overeenkomen met de 
vorm van het object en klik vervolgens op [OK].

Voorbeeld van een geschikt bestand
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Nu worden de contouren van het beeldbestand ach-
terhaald.
Opgelet: Met het “Object”-gereedschap kunt u de vorm 
van het beeld wijzigen, als dit nodig is. Meer details over 
het “Object”-gereedschap vindt u in de online-hulp van 
“Roland CutStudio”.

Delen van een geïmporteerd beeld verwijderen
Als het geïmporteerde beeld een gedeelte bevat dat u 
niet nodig hebt, kunt u dat in CutStudio verwijde-
ren.

A Kies de contouren van het object.

B Klik op [Object]> [Break Polyline].

Nu worden de bestanddelen van het voorwerp ont-
rafeld.

C Klik op het gedeelte dat u wilt verwijderen.

D Klik op [Edit]> [Delete].
Het geselecteerde deel wordt nu gewist. De overige 
data blijven echter behouden.

E Kies nu de resterende delen van het voorwerp door de 
muis erover heen te sleuren.

Om de volledige inhoud van het “CutStudio”-
venster te kiezen klikt u op [Edit]> [Select All]. Ver-
der bestaat de mogelijkheid om de [Bovenkast]-toets 
ingedrukt te houden, terwijl u op alle benodigde 
voorwerpen klikt.

F Klik op [Object]> [Integrate Polylines].

De afzonderlijke contourlijnen worden nu tot één 
object gecombineerd.

‘Object’-
gereedschap
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Handleiding Snijgebied
3-4 Snijgebied

Er wordt altijd een beetje speling voor het materiaaltransport gelaten.

Snijbreedte Snijlengte Toegelaten materiaalbreedte Toegelaten materiaallengte

SV-15 340mm
250mm

1000mm
1000mm

360~381mm
280~305mm

1100mm
1100mm

SV-12 250mm 1000mm 280~305mm 1100mm

SV-8 160mm 1000mm 200~215mm 1100mm

SV-15: SV-12/SV-8:

Aandrukrollen

Snijbreedte: 250mm

Toegelaten materiaalbreedte: 
280~305mm

Snijbreedte: 340mm

Toegelaten materiaalbreedte: 360~381mm

Snijbreedte:
SV-12: 250mm
SV-8: 160mm

Toegelaten materiaalbreedte:
SV-12: 280~305mm
SV-8: 200~215mm

SnijgebiedSnijgebied

Meshouder

MateriaalMateriaal

Meshouder

Aandrukrollen

Marge: 10mm Marge: 10mm

M
ar

ge
: 3

0m
m

M
ax

im
aa

l 1
00

0m
m

M
ax

im
aa

l 1
00

0m
m

M
ar

ge
: 3

0m
m
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3-5 Tips voor het aanbrengen van 
grotere objecten
Hoe groter de sticker, hoe moeilijker het wordt om 
hem recht op de gewenste plaats aan te brengen. Bo-
vendien is het bij grotere objecten waarschijnlijk dat 
niet alle luchtbellen zonder problemen kunnen wor-
den verwijderd.
Om uw kans op verwijderen van alle luchtbellen te 
verhogen verdient het aanbeveling om het opper-
vlak, waarop u de sticker wilt kleven, met een zacht 
schoonmaakmiddel schoon te maken.

A Peal alle niet overtollige materiaaldelen van de onder-
laag en kleef er applicatietape op het object.

B Maak het oppervlak van bestemming schoon.

Het verdient aanbeveling om water met 2~3 drup-
pels zeepsop op het oppervlak aan te brengen.

C Kleef het object op het gewenste oppervlak en schuif 
het zo lang op en neer tot het recht hangt.

D Verwijder het eventueel nog resterende water met een 
waterschraper.

E Wacht tot al het water is verdampt en verwijder ver-
volgens de applicatietape.
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4-1 Schoonmaak
Ziehier een aantal tips voor de schoonmaak van het 
apparaat en de vervanging van het mesje.
Opgelet: Vóór de schoonmaak moet u het apparaat uit-
schakelen en het eventueel nog aanwezige materiaal ver-
wijderen.

Mesje schoonmaken
Opgelet: Raak het mesje nooit met blote vingers aan. An-
ders is de kans op verwondingen namelijk betrekkelijk 
groot.
Als er nog materiaaldeeltjes aan de meshouder en het 
mesje zelf hangen, laat de kwaliteit van de volgende 
snijopdracht eventueel te wensen over. Verwijder 
dus alle materiaaldeeltjes en lijm.

Schoonmaken van de meshouder
Opgelet: Raak het mesje nooit met blote vingers aan. An-
ders is de kans op verwondingen namelijk betrekkelijk 
groot.
Als er aan de kap materiaalresten of stofdeeltjes blij-
ven hangen, gaat de snijkwaliteit zienderogen achter-
uit.
Open de meshouder en verwijder alle materiaalres-
ten e.d.

Schoonmaken van de hoofdeenheid
De ombouw mag u uitsluitend met een droge doek 
schoonmaken. Gebruik nooit oplosmiddelen, zoals 
verdunners of benzine.

4-2 Smeren van de wagenstang
Als de wagenstang lijm of kleine materiaaldeeltjes 
bevat, worden de objecten niet meer naar behoren 
uitgesneden. In de volgende gevallen moet u de kap 
van de wagenstang verwijderen en de stang zoals 
hierna beschreven smeren. Gebruik hiervoor machi-
neolie.

A Verbreek de aansluiting op het lichtnet.

B Verwijder de kap van de wagenstang.

Draai de schroeven los met een Phillips-schroeven-
draaier en verwijder ze.

4. Onderhoud

Draai de kap in de getoonde 
richting om hem te kunnen 
verwijderen.

Schokkende bewegingen

Abnormaal lawaai
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C Verwijder al het stof en alle materiaaldeeltjes van de 
stang.

D Giet een beetje machineolie op het in de illustratie ge-
toonde gebied van de stang.

Opgelet: Wees zuinig met de olie om te voorkomen dat hij 
op een later tijdstip op het materiaal drupt.

E Installeer de kap van de wagenstang opnieuw en draai 
de eerder verwijderde schroeven weer aan.

4-3 Vervangen van gebruiks-
goederen

Vervangen van het mesje
Als het mesje bot en duidelijk beschadigd is, moet u 
het vervangen. Dit is bovendien noodzakelijk, wan-
neer u met de juiste meshoogte geen optimaal resul-
taat meer bereikt. Installeer dan een nieuw mesje.
Alvorens het mesje te vervangen moet u het materi-
aal verwijderen.
Opgelet: Raak het mesje nooit met blote vingers aan. An-
ders is de kans op verwondingen namelijk betrekkelijk 
groot.

A Verbreek de aansluiting op het lichtnet.

B Draai de schroeven los en haal de meshouder uit de 
wagen.

C Druk op de drukpin om het mes uit de meshouder te 
drukken.

Druk de pin zo ver tot u hem niet meer kunt zien.

D Schuif het mesje zo ver in de meshouder tot het vast-
klikt.

De pin springt uit de houder.

E Stut de schroef af, terwijl u de meshouder weer instal-
leert.

Schroef

Meshouder

Versleten mesje

Drukpin

Nieuw mesje

Moet de houder
raken Langs onder 

afstutten.
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Handleiding Vervangen van gebruiksgoederen
F Draai de schroef weer aan.

Trek de cutter voorzichtig omhoog om te controle-
ren of hij goed vast zit.

Mesbeschermer vervangen
Kijk ook even hoe de mesbeschermer er uitziet. Lich-
te krassen zijn niet erg en hebben geen invloed op de 
snijkwaliteit. Als er echter sprake is van ernstige in-
kepingen, dan moet u de mesbeschermer vervangen. 
Gebruik hiervoor de reserve-mesbeschermer.
Opgelet: Het hier getoonde mesje is erg scherp en zou ver-
wondingen kunnen veroorzaken. Wees dus voorzichtig tij-
dens het hanteren ervan.

A Verbreek de aansluiting op het lichtnet.

B Verwijder de oude mesbeschermer door hem met een 
cuttermes los te maken.

Gebruik een in de handel verkrijgbaar cuttermes. Al-
vorens de mesbeschermer van de SV-15 los te maken 
dient u beide laadhendels op te tillen.

C Verwijder alle lijmresten uit het apparaat.
Gebruik voor de schoonmaak een doek.

D Installeer de nieuwe mesbeschermer in de daarvoor 
voorziene uitsparing.

E Schuif de mesbeschermer tot aan de hulplijn op het 
apparaat.

F Verwijder de onderlaag van de dubbelzijdige tape en 
kleef de mesbeschermer op het apparaat.

In het geval van de SV-15 moet u de twee laadhendels 
nu weer laten zakken.

Schroef

Meshouder

Opgelet: Houd de andere hand nooit op een plaats 
waar het waarschijnlijk is dat u zich met de cutter 
kunt snijden, wanneer deze laatste wegglipt.

Hulplijn

Laadhendels
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5-1 Eerste hulp bij problemen…
Ziehier een aantal tips voor het verhelpen van ver-
meende storingen. Lees dit hoofdstuk alvorens te be-
sluiten dat het apparaat wel degelijk defect is. Ant-
woorden op vragen, die hier niet aan bod komen, 
vindt u waarschijnlijk in de “Windows Advanced 
Guide” of “Macintosh Cutting Guide” (elektroni-
sche documenten). Neem die dus eveneens door, als 
iets onduidelijk blijft.

Het apparaat voert de commando’s niet uit
Hebt u de kabels naar behoren aangesloten?
Als het netsnoer of de USB-kabel niet naar behoren 
is aangesloten, moet u de nodige maatregelen treffen. 
Zie “Kabels aansluiten” op blz. 10.

Hebt u de driver naar behoren ingesteld?
Misschien hebt u de foute communicatiepoort geko-
zen.

Knippert de stroomindicator?
Dat wijst op een communicatiefout of een fout com-
mando. Schakel het apparaat uit en controleer de 
verbindingen evenals de communicatieparameters 
van de driver.

Als u op de [POWER]-knop drukt, wordt het apparaat 
niet volledig uitgeschakeld.
Verbreek dus de verbinding met de adapter en/of het 
stopcontact.

De objecten worden vervormd of maar gedeelte-
lijk uitgesneden

Is de meshoogte naar behoren ingesteld?
Corrigeer dit indien nodig. Zie “Meshoogte instel-
len” op blz. 20.

Hebt u de meshouder naar behoren vastgezet?
Draai de schroef aan om te voorkomen dat hij tijdens 
het gebruik los komt te zitten.

Is het mesje eventueel afgebroken?
Installeer dan een nieuw mesje. Zie blz. 28.

Niet alle objecten worden volledig uitgesneden.
Is het mesje eventueel afgebroken?
Installeer dan een nieuw mesje. Zie blz. 28.

Is het mesje eventueel vuil?
Verwijder alle materiaalresten van het mesje. Zie 
“Mesje schoonmaken” op blz. 27.

Kleven er eventueel materiaaldeeltjes en stof aan de 
meshouder?
Open de meshouder en verwijder alle materiaalres-
ten e.d. Zie “Schoonmaken van de meshouder” op 
blz. 27.

Is de mesbeschermer sterk beschadigd?
Als de mesbeschermer beschadigd is, worden de ob-
jecten zelfs dan niet naar behoren uitgesneden, wan-
neer de instellingen op het apparaat, de meshoogte 
e.d. allemaal kloppen. Installeer een nieuwe mesbe-
schermer. Zie blz. 29.

Is de meshouder beschadigd of versleten?
Gebruik een nieuwe meshouder.

Tijdens het uitsnijden verschuift de oorsprong
Is de meshoogte naar behoren ingesteld?
Corrigeer dit indien nodig. Zie “Meshoogte instel-
len” op blz. 20.

Werd het materiaaltransport belemmerd?
Zet geen voorwerpen vóór of achter het apparaat. 
Zoiets kan namelijk het materiaaltransport belem-
meren en ervoor zorgen dat de oorsprong verschuift.

Tijdens het uitsnijden verschuift de oorsprong 
naar links/rechts

Als de oorsprong zoals hierna getoond verschuift, 
moet u de volgende punten even controleren.

Is de meshoogte naar behoren ingesteld?
Corrigeer dit indien nodig. Zie “Meshoogte instel-
len” op blz. 20.

5. Appendix

De afstand tussen 
de letters is niet 
constant

Het snijpad lijkt 
verschoven te zijn
30



Handleiding Vervangen van gebruiksgoederen
Beweegt de snijwagen niet zoals anders en hoort u 
eventueel een vreemd geluid?
Verwijder alle materiaalresten en eventueel stof van 
de wagenstang en smeer deze laatste. Zie “Smeren 
van de wagenstang” op blz. 27.

Het materiaal verschuift tijdens het uitsnijden.
Is het materiaal langer dan 500mm?
Materiaal met een lengte van meer dan 500mm kan 
inderdaad verschuiven. Voer het dan opnieuw in of 
gebruik korter materiaal.

Is het materiaal eventueel te kort?
Kort en bijzonder zacht materiaal kan tijdens het uit-
voeren van een snijopdracht verschuiven. Gebruik 
dan een ander materiaaltype of een langer vel.

Lopen de materiaalranden parallel met elkaar?
Als de materiaalranden schuin zijn, moet u ze recht 
afsnijden om te zorgen dat ze parallel met de hulplij-
nen lopen.

Werd het materiaaltransport belemmerd?
Gebruik altijd materiaal met een ondersteunde 
breedte. Het materiaal mag tijdens het transport 
geen enkele partij van het apparaat raken. Dat kan 
namelijk leiden tot transportfouten, wat op zijn 
beurt het materiaal kan beschadigen.

Is het materiaal vervormd en begint het te golven?
Zoiets kan het materiaaltransport belemmeren en 
ervoor zorgen dat het materiaal verschuift. Verwij-
der het geplooide of golvende materiaalgedeelte en 
laad het materiaal opnieuw.

Wat doen, als de driver niet kan worden 
geïnstalleerd?

Als de installatie halverwege stopt c.q. als de wizard 
na het aansluiten van de USB-kabel niet verschijnt, 
moet u het volgende doen.

A Als de “Wizard Nieuwe hardware gevonden” ver-
schijnt, moet u op [Voltooien] klikken om hem weer 
te sluiten.

B Roep de “Systeemeigenschappen” op.

Windows XP

Klik op de [Start]-button en vervolgens met de rechter 
muisknop op [Deze computer]. Klik op 
[Eigenschappen].

Windows 2000

Kik met de rechter muisknop op [Deze computer] (op 
het bureaublad). Klik op [Eigenschappen].

C Klik op de “Hardware”-tab en vervolgens op 
[Apparaatbeheer].

Nu verschijnt het “Apparaatbeheer”-venster. Wis 
het icoontje van de modelbenaming (of het “Onbe-
kende apparaat”).

D Klik in het “Weergave”-menu op [Verborgen appara-
ten weergeven].

E Zoek de “Printer”- of “Andere apparaten”-map en 
dubbelklik erop.

F Klik op het icoontje van de modelbenaming (of het 
“Onbekende apparaat”).

G Kies, onder [Handeling], de [Installatie ongedaan ma-
ken]-optie.
Het display beeldt nu de volgende boodschap af.

H Klik op [OK].

I Sluit het “Apparaatbeheer”-venster weer en klik op 
[OK].

J Verbreek de USB-verbinding met de computer.

K Herstart Windows. Zie daarvoor “Verwijderen van de 
driver”.

L Installeer de driver opnieuw. Zie “Driver installeren” 
op blz. 11.
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Windows 98 SE/Me

A Zie “Verwijderen van de driver” verderop.

B Installeer de driver opnieuw. Zie “Driver installeren” 
op blz. 11.

Verwijderen van de driver
Ziehier wat u moet doen om een geïnstalleerde dri-
ver te verwijderen.
Opgelet: Verbreek de USB-aansluiting van het apparaat op 
de computer alvorens de deïnstallatie te starten.

A Start Windows. Als u de software onder Windows 
2000/XP installeert, moet u aanloggen als “beheer-
der” of een gebruiker met dezelfde machtigingen.

B Stop de bijgeleverde CD-ROM in de drive.
Klik op [X] rechtsboven om het venster te sluiten.

C Klik op de [Start]-button en vervolgens op 
[Uitvoeren].

D Voer de volgende informatie in en klik vervolgens op 
[OK].

Windows 2000/XP
(Letter van de CD-ROM-drive):\Dri-
vers\WIN2KXP\SETUP.EXE

Windows 98 SE/Me
(Letter van de CD-ROM-drive):\Dri-
vers\WIN9X\Setup.exe

E Het “Setup”-programma wordt gestart en het Driver 
Setup-venster verschijnt.

F Kies [Uninstall].

G Kies het apparaat dat u gebruikt.

H Klik op [Start].

I Klik op [Ja] om de computer te herstarten.

In deze illustratie heet de CD-ROM-drive “D”.
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5-2 Specificaties

*Als het materiaal langer is 500mm, zou het tijdens het transport kunnen verschuiven, wat ertoe leidt dat de objecten niet naar behoren worden 
uitgesneden.
**Bepaalde materiaaltypen zijn niet geschikt voor gebruik met dit apparaat.

SV-15 SV-12 SV-8

Snijprocédé Materiaaldoorvoer

Maximaal snijgebied Breedte: 340mm
Lengte: 1000mm

Breedte: 250mm
Lengte: 1000mm

Breedte: 160mm
Lengte: 1000mm

Toegelaten materiaalafmetingen (*) Breedte: 360~381mm
Lengte: Maximaal 1100mm

Breedte: 280~305mm
(lengte: A3, breedte: A4)

Lengte: Maximaal 1100mm

Breedte: 280~305mm
(lengte: A3, breedte: A4)

Lengte: 1100mm

Breedte: 200~215mm
(lengte: A4)

Lengte: Maximaal 1100mm

Snijsnelheid 12~100mm/sec. 12~40mm/sec. 12~40mm/sec.

Toegelaten materiaaltypen (**) Vinylfolie (maximale dikte: 0,1mm; maximale dikte met onderlaag: 0,3mm)
Labelpapier (maximale dikte met onderlaag: 0,3mm)

Interface USB 1.1

Voeding Aansluiting voor de adapter AC100V ±10%, 50/60Hz; 1,7A
Uitgang: DC 19V, 2.1A

Opgenomen vermogen ±20W (inclusief adapter)

Afmetingen (B x D x H) 522 x 205 x 115 mm 440 x 205 x 115 mm 340 x 205 x 115 mm

Gewicht 3,3kg 2,7kg 2,2kg

Geluidsniveau 60dB(A) of minder (conform ISO7779)

Systeemvereisten Temperatuur: 5~40˚C, luchtvochtigheid: 35~80% (zonder condensatie)

Bijgeleverde accessoires Zie blz. 8.
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